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Understanding your Support

Review support maintenance programs and offerings.

Registering for Support
Access the erwin support site and click Sign in or Sign up to register for product support.
Accessing Technical Support

For your convenience, erwin provides easy access to "One Stop" support for all editions of
erwin Data Modeler, and includes the following:

® Online and telephone contact information for technical assistance and customer ser-
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® Information about user communities and forums

® Product and documentation downloads

® erwin Support policies and guidelines

® QOther helpful resources appropriate for your product

For information about other erwin products, visit http://erwin.com/products.

Provide Feedback

If you have comments or questions, or feedback about erwin product documentation, you
can send a message to techpubs@erwin.com.

erwin Data Modeler News and Events
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Introduction

The Feature Tour guide walks Data Architects, Data Administrators, Application Admin-
istrators, Database Administrators, and Partners through the features introduced in erwin
Data Modeler (DM) 2021 R1 release.

The features and enhancements introduced in this release are:

® erwin Mart Administrator Ul Facelift

®" NoSQL Modeling

® JSON and AVRO Support

" QOracle 12c R2, 18¢,19c, and 21c

" Microsoft SQL Server 2019

" Microsoft Azure SQL

" MySQL

® Data Vault 2.0 Support

® Productivity and Ul Enhancements

® JDBC Support

For additional information about a feature, in erwin Data Modeler, click Help > Help Topics
on the toolbar or press F1.



erwin Mart Administrator Ul Facelift

erwin Mart Administrator now comes with a brand new Ul that follows Google’s Material
Design principles. The redesigned Ul offers an improved user experience with its modern
look and feel, dark and light modes, and graphical buttons and icons.

Apart from the overall facelift, the wiki-like editable Home page lets you add information,
such as key text, process diagrams, important hyperlinks, resources, and much more. Also,
the configurable Dashboard let’s you add and view a pictorial presentation of your data and
actions on the Mart. You can add charts for your data footprint, model overview and his-
tory, profile data, and session overview.

For more information, refer to the erwin Mart Online Help.



https://erwin.com/bookshelf/public_html/2021R1/Content/User Guides/Mart Online Help/Online Help.html

NoSQL Modeling

Along with relational databases, erwin Data Modeler (DM) now supports the following
NoSQL, non-relational databases as target databases:

® MongoDB 4.x
® Cassandra 3.x
® Couchbase 6.x

These NoSQL databases support all the erwin DM features and functions. The following sec-
tions will take you through these features with MongoDB database as an example:

® Migrating a relational model to NoSQL model

® Reverse engineering models from database and script

® Forward engineering models to database

" Comparing changes using Complete Compare




MongoDB Support

erwin Data Modeler (DM) now supports MongoDB 4.x as a target database. This imple-
mentation supports the following objects:

"= Databases

" Collection
" Collation

" |ndex

Relationships

User IDs
" Roles
" View

The following table lists the supported data types:

Numeric String Lit- Date and Time Other
erals

o double e string o date e Object

e binary o timestamp e array

e int e null

o integer e Objectld

e boolean o regex

e minKey e code

¢ maxKey

e long

o decimal
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https://erwin.com/bookshelf/public_html/2021R1/Content/User Guides/erwin Help/MongoDB_Support_Summary.html

Cassandra Support

erwin Data Modeler (DM) now supports Cassandra 3.x/4.x as a target database. This imple-

mentation supports the following objects:
" Aggregate
® Function

" Keyspace

Materialized View

" Materialized View Column

" Role

Table
® Table Column
" Index

" User Type

The following table lists the supported data types:

Category Data Type Supported Constants
Native e asCii e string

o bigint o integer

o blob e blob

e boolean e boolean

e counter e integer

o date e integer, string

o decimal o integer, float

o double o integer, float

o float o integer, float

11


https://erwin.com/bookshelf/public_html/2021R1/Content/User Guides/erwin Help/Cassandra_Support_Summary.html

inet string
int integer
smallint integer
text string
time integer, string
timestamp integer, string
timeuuid uuid
tinyint integer
uuid uuid
varint integer
Collection list
map
set
Tuple tuple

12



Couchbase Support

erwin Data Modeler (DM) now supports Couchbase 6.x as a target database. This imple-
mentation supports the following objects:

" Bucket
® Document

" Fjeld

Full Text Index

Global Index
® UserID
® View
Following are the supported data types:
" MISSING
" NULL
® BOOLEAN
" NUMBER
® STRING
" ARRAY
® OBIJECT
® BINARY

13


https://erwin.com/bookshelf/public_html/2021R1/Content/User Guides/erwin Help/Couchbase_Support_Summary.html

Migrating Relational Models to NoSQL Models

You can convert and migrate your relational models to NoSQL models in two ways:

" Changing the target database

® Deriving a model

This topic walks you through the steps to migrate a SQL Server model to a MongoDB model.
Similarly, you can migrate your relational models to Cassandra and Couchbase models.

Note: Ensure that you keep a backup of your original models.

Migration by Changing the Target Database

To migrate by changing the target database, follow these steps:

1. Open your relational model in erwin Data Modeler (DM).
Note: Ensure that you are in the Physical mode.
For example, the following image uses the sample eMovies.erwin model. In the
Objects Count pane, note the number of tables, columns, and relationships.

eMovies.erwin X ~  Objects Count 1 x
~ Mame: EMOVIES 2021R1
. . .
erwin, Inc. Type: Logical/Physical
[The Caztomar Nomberwas ~— — !
= erwin Samlﬂe Diainm (] tulenamedtopne\rem unification. | View Mode: Logical
eMovies.erwin EERT
. . - —
Feymentinanzaction numesr Subject Areas: 4 Key Groups: 30
paymant byps:
e — — — —— Eeyment amcunt M Entities: ] Relationships: 13
| e [ErT—— Attributes: 5 Sub-Categories: 0
— boms bsr (FK)
| r T T supavizoranpioyeanuntss i |
I | chack bark number b oyen addras
check numbss redelves | employes addrezs 2
| | &Py vendarnumess N o e iene Style:  Pie Style (3D) ~  Pallete: VibrantP:
pay account numbsr ot e mumber — —
"'r"“" cradlt cand numbss e
L (] ey cradlt card axp pme
CUSTOMER | cradit <ard byps: emall e
sbore numbser (FK)
Cusbomer numbss | -
tomar add T
B | |
ko, {l
. | -
customer lasknams: lﬂllrﬂs
cusbomer shabe é —E
customer zIp codk
CUSTOMER CRENT I
cusbomar numbsss l
complates
credlt card MHOWVIE RENLAL RECORD |5 complatad by
cradlbcand &ap
Stabs code rankal recond dabe (¥
menile e mimbe £
>
Drawing Objects/<P hysical with ‘u’iewsKAttributefC elumn Di splay/ Properties | Objects Count
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2. On the ribbon, click Actions > Target Database or on the status bar, click the database
name.
The erwin Data Modeler -- Target Server screen appears.

erwin Data Modeler -- Target Server >

Database: SOL Server “~ | S0L Server Yersion é'guj_ﬁl,rzuﬂ W

Default SQL Server Datatype
| char(18) v

Default Mon-Key Mull Option
() NOT NULL

() NULL

Cancel

3. In the Database drop-down list, select MongoDB.
By default, the Auto Denormalization check box is selected. Keep it selected.

erwin Data Modeler -- Target Server X
Database: MongoDB Pv MongoDB Version 4% ~
Auto Denormalization Default MongoDB Datatype

| String ~ |

Default Non-Key Null Option
[ JNOT NULL

4, Click OK.
The conversion process starts.

15



Embedding...

Processing Data : (&) / (249) - (25)%

Cancel

Once the conversion is complete, the existing model in migrated to a NoSQL database.

erwin, Inc.
erwin Sample Diagram
eMovies.erwin

CusT

CUST_numbsr
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payment_date
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cradlt_cand monle_tile v
sradlt_cand_zep mawle_director masle_numess
alatuz_code descripticn sbore_numess
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e rating vl
papment_ranzacticn_numbss atar_2_nama: EUP_frst_nama
paymant_fiee ganre EWP_address
CHET LR rental _sabe EWP_phone
payment_date mewle_ur EMP_address_
payment_stibiz manle_cllp: $00_ges_number
A TR ATES WO IE_STORE hire_date:
check_numesr Sl e
pay_vendor_numbss RO e
LSRRI atore,_numbar EUP_numess
AR AT AL WOV IE_COPT sbore_numess
cradit_cand_axp v AETET
cradit_cand_typs gensral_conditicn PATMENT
EMF_mumbsr maulz_fomat vl
customar_na AL b [aymant_anz
T mesls_numbsr Faymant_typs:
WOL_REKT_REC WC_REHT_REC: paymant_amouy
Ll v Fayment_date:
Gt rantal_date: paymant_stabus
(AT dus_date <hssk_Esnk_n
rental_statz rental_stabuz chack_numbser
G ouandue_chane 2pay_vander_n
S renkal_sabe epay_account, ¥

\Drawing ObjectsAPhysical with ‘u‘iewsAAttributa"Column Display/

>

Objects Count o x
MName: EMOVIES 2021R1
Type: Logical/Physical
View Mode: Physical
Subject Areas: 4 Indexes: 10

Collections: 4
207

Relationships: 0
Fields:

Style:  Pie Style (30) ~  Pallete: vibrant

_af
T

N’

Properties | Objects Count

In the Objects Count pane, note that instead of tables and columns, we now have col-
lections and fields. Also, the Relationships count has changed to 0. The migration pro-
cess converts and merges multiple tables, columns, and relationships to the NoSQL

format according to the database that you select.

Note: This migration method overwrites the existing model once you save it. Hence,
we recommend that you keep a backup of your original model.

Migration by Deriving a Model

To migrate by deriving a model, follow these steps:
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1. Open your relational model in erwin Data Modeler (DM).
Note: Ensure that you are in the Physical mode.
For example, the following image uses the sample eMovies.erwin model. In the
Objects Count pane, note the number of tables, columns, and relationships.

eMovies.erwin X - e i
~ MName: EMOVIES 2021R1
. . .
erwin, Inc. Type: Logical/Physical
' [The Customar Nomberwas ~— ~ ! § X
= erwin Sample Diagram . foleniamer topravent unification. | View Mode: Logical
oo T e
eMovies.erwin EoEnET
. . - —_—
Ed¥ SN Tan S acicn IumESy Subject Areas: 4 Key Groups: 30
makas ¢ DRment YOS i+ : :
ey — — — — — & caimantanaun: - Entities: 9 Relationships: 13
| e s [EE—— Attributes: 75 Sub-Categories: 0
— cusbomer numbss (FK)
| r R AT supsnizorsmpioesnumoer i L
| heck bank numess ey
I check numbss radedues ¢ | empiovss addrass =
| | epay vendarnumber 15 v B T Style:  Pie Style (30) - Palletet  Vibrant Pz
Spay aoCount num s e T -—
mgkiss ¢ cradlE cand number A
L (| mer credit card axp e
CUSTOMER | cralt card byps: emall e
shora numbsar (FK)
Cuskomarnumess | L
cusbomer address I o —
wmall |
cusbomar <l =
it o S | e
customer last nams Ires
customer state
customer zIp code é —E
CUSTOMER CRENT I
cusbomar numbsss l
complates
cradlt card MHOVIE RENLAL RECORD |5 complatad by
cradlt card @ep
A rantal recond date e
mevils roew numbr (F1
>
Drawing Objects/(:Physical with ‘u’iewsKAttributefColumn Display/ Properties | Objects Count

2. On the ribbon, click Actions > Design Layers > Derive New Model.
The Derive Model screen appears. By default, the Source Model is set to your current
model.
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Derive Model
select the Target Model Compare Level:

Please select the options to create a new derived model Linknown

Mew Model Type
() Logical () Physical

Create Using Template:

Blank Logical Physical Model

Remove Browse File System... Browse Mart...

Creates a new model with both logical and physical levels (erwin DM dassic)
and default settings.

Target Database
Database: SOL Server e Version: | 2016/2017 e
Auto Denormalization Auto Mormalization Relationships

< Back | Mext = | Derive Close Help

3. Inthe Database drop-down list, select MongoDB.
By default, the Auto Denormalization check box is selected. Keep it selected.

18



Derive Model
select the Target Model Compare Level:

Please select the options to create a new derived model Linknown

Mew Model Type
() Logical () Physical

Create Using Template:

Blank Logical Physical Model

Remove Browse File System... Browse Mart...

Creates a new model with both logical and physical levels (erwin DM dassic)
and default settings.

Target Database
Database: MongoDB ~ Version: | 4.x =
Auto Denormalization Auto Mormalization Relationships

< Back | Mext = | Derive Close Help

4. Click Next.
Note: If the Type Resolution screen appears, click Finish.
The Type Selection section appears.
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Derive Model

Derive Model Type Selection

Overview

Source Model

Target Model

Please select the types of objects to be Derived

Compare Level:

Logical and Physical

Filter Level
Logical Level Physical Level []Database Level
Option Set: | Advanced Default Option Set e =]

Bt

&| Properties
m Annotation
ﬂ Bridge Defaults
= Data Movement Rule
|j_j| Data Source Object
& Data Vault 2.0
1@ Data vault Attributes
ﬂ Datatype Standard
ﬂ Default Trigger Template
: Y Default value
Eﬁl Domain
&-[M] 5 Entity/Table
|§| ER. Diagram
7] @ Extended Nates

< Back Derive Close

| Mext > |

Help

Select the types of objects that you want to derive into the target MongoDB model.

Click Next.

The Object Selection section appears. Based on the object types you selected in step

5, it displays a list of objects.
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Derive Model

Source Model Object Selection
Please select the objects you want to linked to the derived model

Choose Chiects Using Sets

Compare Level:
Logical and Physical

Selected Objects:

w-ME
1A ZF Indexes

ﬂ* Triggers

_ & schemas

E’ Owned By

Overview

Source Model

Target Model

=1 [ EMOVIES 2021R1
ﬁ*ﬁ Annotations
ﬁ Datatype Standar:
M@ Default Trigger Te
¥ Default values
[1[B% Domains

1 E% Entities/Tables
réﬁ ER. Diagrams
M@ 1mages

ﬁ Maming Standards
ﬁ Page Setup
[} Relationships

ES' Subject Areas

A¥ Themes

[ & Trigger Templates
----.Jﬁ User Ids

£ >

"~

< Back | Mext = |

[ ]Hide unselected objects

Derive Close Help

Select the objects that you want to derive into the target MongoDB model.

Click Derive.
The model derivation process starts.
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Embedding...

Processing Data : (13) [ (24) - (54)%

Cancel

Once the conversion is complete, the existing model in migrated to a NoSQL database.

STORE

o

= EMP
o

e
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store_numbes

ERAP_first_rame
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EbAF_phaone
EMP_addreszs 2
S0C_Ses_numbss
hire_date

Falary

email
ERAP_rumber
store_number

-

MINE

e _riumbss

mote_tite

mioie_director

dezcription

ztar_1_name

rating

star_2_name

qenre

rental_rate

mowie_uid

mavie_cip

1= b %I E_STORE

MU
miovie_numiber
store_number

= b O%IE_CORY

MU
general_condition
mioie_fiamme
M0_50_Mum
e _numiber

G hi0_REMT_REC

¥ 0]

rental_dats
Aa Ampa

~

Objects Count o x
Mame: EMOVIES 2021R1
Type: LogicalPhysical
View Mode: Physical
Subject Areas: 4 Indexes: 10

Colections: 4
Fields: 207

Style:  Pie Style (30) -

Relationships: 0

Pallete:  Vibrant P

___...-l

Properties | Objects Count

In the Objects Count pane, note that instead of tables and columns, we now have col-

lections and fields. Also, the Relationships count has changed to 0. The migration pro-

cess converts and merges multiple tables, columns, and relationships to the NoSQL

format according to the database that you select.
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Reverse Engineering Models

You can create a data model from a database or a script using the Reverse Engineering pro-
cess.

This topic walks you through the steps to reverse engineer a MongoDB model. Similarly, you
can reverse engineer a model from your Cassandra Keyspace and Couchbase Bucket.

To reverse engineer a model:

1. In erwin Data Modeler (DM), click Actions > Reverse Engineer.
The New Model screen appears.

MNew Model >

Type
Logical  (_JPhysical (@) Logical/Physical () Match template

Target Server

[Imatch template target server

Database: MongoDB | Version: &,

Template

<Default> ™ | [é' @

Preserve the template binding

2. Click Logical/Physical and set Database to MongoDB.

3. Click Next.
The Reverse Engineer Process Wizard appears.
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|87 Reverse Engineer Process Wizard |

Reverse Engineer Process Overview
This page provides an overview of the Reverse Engineer Process,

Database
Collection

Option Set

Detail Options

Scheduler

Reverse Engineer From
@53

File: Browse...

() Script File

Overview ~

Welcome to theReverse Engineer Wizard. Thiswizard lets you reverse engineerfram the physical
databasze.

Reverse engineering is the process of generating the physical database schema from a physical
maodel. You can customizethe Reverse Engineer foryourtarget serverusing features in the Detail
options.

The Option Set page |ets you customize the Reverse Engineer option s&t.

The Scheduler page lets vou customize the Reverse Enginaer Scheduler options. The page dso
lets youuse Complete Compare and Martfor thetarget location.

The OwnerOverride page lets you enter the owner override name of an object group. The object
group and name youindicate override the owner name assignment forthat abject group in the
model.

The Collection Filter pagelstsyouselect asubset of the tablesin a modelfor Reverse
engineering.

The Preview page lets youpreviewthe schema DDL script generated forthecurrent model. [¥]

< Back ok || cancel || Hep

4. Click one of the following options:

« Database: Use this option to reverse engineer a model from your database.

o Script File: Use this option to reverse engineer a model from a script. Selecting
this option enables the File field. Click Browse and select the necessary script

file.

File:

Reverse Engineer From

() Database

| Coowe |

Note: If you click Script File, jump to step 8 below and ensure that Document

Count or Document % is not set to zero (0).

5. Click Next.
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The Connection section appears. Use this section to connect to the database from
which you want to reverse engineer the model. You can connect to the database dir-

ectly or using a connection string. The following table explains the connection para-
meters:

Connection Parameters/Values
Method

Specify the MongoDB Connection String.
For example: mongodb+srv://<abcd>:****QA<xyz>.mon-
godb.net/test?retryWrites=true&w=majority

Connection

String Replace <abcd> with your username and <xyz> with host name. The host
name parameter would change based on your MongoDB deployment;
standalone, replica set, or a sharded cluster.
Specify the host name and port number of your

Direct MongoDB deployment. Also, specify the database that you want to con-

nect to.

25



In the following image, for example, the connection is being established using a con-
nection string.

|87 Reverse Engineer Process Wizard O *

Reverse Engineer Connection Information
This page provides a Reverse Engineer Connection Information.

Database |MongoDB 4% il |

Authentication Database Authentication b
Database Lser Name | |
Collection Passvors | |
Option Set

Parameters Value

Detail Options Connection Method CONNECTION STRING
Scheduler Connection String: mongodb+srv . T "gra.m

—

Recent Connections:

doud.mongodb:fe s (MongoDB 4.x)

<ot | [ o> 5 ]| cmm || b |

Click Connect.

On successful connection, your connection information is displayed under Recent Con-
nections.

Click Next.
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The Database section appears. It displays a list of available databases.

|87 Reverse Engineer Process Wizard O b4

Database Selection Options
This page allows the user to select available database list.

Available Databases: Enter fiter fext Selected Databases:

_Mongo_Collation_01 {4)
_Mongo_Collation_Comment (3)

Collection dbname (3)

Option Set finandial (5) I::>
MaongoDB_View_01 (1)

Detail Options newDB (2) <:|

Scheduler sample_airbnb {2)

sample_analytics (3)
sample_geospatial (1)
sample_mflix (5)
sample_supplies (1)
sample_training (12)
sample_training_test (1)
sample_weatherdata (1)
test (3)

& ]

Items: (15) Ttems: {0)

| <Back | [ next> | [ ok ] cancel || e |
4

Under Available Databases, select the databases that you want to reverse engineer.
Then, click B
Available Databases: Enfer fWiter fext

_Mongo_Collation_01 (4)
_Mongo_Collation_Comment (3)

dbname (3)
@ finandal {5) E
<

a MongoDB_View_01 (1)
newDB (2)
sample_airbnb (2)

sample_analytics (3)
sample_geospatial (1)
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This moves the selected databases under Selected Databases.

Available Databases: | Enfter fWter fext Selected Databases:
_Mongo_Collation_01 (4) finandal (5)
_Mongo_Collation_Comment (3) MongeDB_View_01 (1)
dbname (3)

sample_airbnb {2)

newDB (2)
sample_analytics (3) <::|

9. Click Next.
The Collection section appears. It displays a list of available collections in the data-
bases that you selected in step 8.

B Reverse Engineer Process Wizard O X

Collection Selection Options
This page allows the user to select available collection list.

Sampling
|Document Count V || 0 | [«]Deep Search (@) Sequence () random

Available Collections: Enter fter fext Selected Collections:

Hbookz (1)

H collection_view_001 (2)
H employee (1)

Option Set Hitemz2 (1)
Hnewproduct (1)

[ newproductz (1)

r| B2

Detail Options

Scheduler

4l (@l

Items: (2) Items: (0)

| <Back || Next> [ ok ] cancal | Hep

10. Use the following options:
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o Document Count/Document (%): Use this option to specify the number of doc-
uments or percentage of total records that the newly generated model schema
would contain.

o Deep Search: Use this option to specify whether the deep search algorithm is
used to retrieve the right samples for schema generation.

o Sampling: Use the Sequence or Random sampling methods to sample records in
the selected collections. Sampling enables you to retrieve right estimates for
accurate collection schema generation.

11. Under Available Collections, select the collections that you want to reverse engineer.
Then, click =

Available Collections: | Enter fiter text |

ook (1)
collection_View_001 (2)
employee (0)
tem2 (1)
newProduct (1)
A newProduct? (1)

This moves the selected collections under Selected Collections.

Available Collections: | Enter fter fext | Selected Collections:
A newProduct? (1) Hbookz (1)
H collection_view_001 (2)
H employee (0)
B | Hitem2 (0
H newProduct (1)
12. Click Next.

The Option Set section appears. It displays the default option set. You can either use
the default or a custom option set.
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|87 Reverse Engineer Process Wizard O »

Reverse Engineer Option Set
This page allows the user to select the Reverse Engineer Option Set.

Items to Reverse Engineer

OptonSet: | Open.. | Save | |Saveds.. | Delete |

| Defauit Option Set - Database )

Collection =-[m] [ Model

G- [m](#, User 1d
[ Database
13 collection
-0 View

Detail Options

Scheduler

< | (] o | Gl || ran ]

13. Click Next.
The Detail Options section appears. Set up appropriate options based on your require-
ment.
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|87 Reverse Engineer Process Wizard

Reverse Engineer Detail Options

This page provides a Detail Options of the Reverse Engineer Process.,

T MN5M Options
Glossary CSV File: | | Browse...
Connection
Reverse Engineer
Databas
S System Objects

Collection Collections/Views Owned By
Option Set @ al (O current User

(C) owners (comma separated):

Infer

From
[ erimary Keys Indexes
[ relations Names

Case Conversion of Physical Names
@ mnone (lower (JUPPER [ Force

Case Conversion of Logical Mames

(®) Nong

Indude Generated Triggers

Olower (JUPPER () Mixed

<Back

EoNext»

14. Click OK.
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The reverse engineering process starts.

Reverse Engineer from Database O >

(=) Reverse Engineer

A
Once the process is complete, based on your selections, a schema is generated and a

model is created.

Model7 X v Properties o x
B=;

A ||B= E’b d @
: 4 General ~
book? item2 MName Model 7
oo _id E Author
id Sitem | Definition
itle |
= author | Logical Notation Information Engineering
[ | Physical Notation Information Engineering
page]s | Current ER Diagram ER_Diagram_118
language | collection_View_001 Current Subject Area
publisher_id | i Current DSM Option Set
available | - Current NSM Option Set
= Teradats_tablel || Firsthame Allow Manual Relationship [
¥ [0 | Last{\.lame Unigue Mames Mot Unigue
a | pasmon ———
h | wage Is N5M Option From AMT
- | " o——————— 4 Defaults v
B User |
v ; 9
< >
ER_Diagram_118 Properties | Objects Count
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Forward Engineering Models

You can generate a physical database schema from a physical model using the Forward
Engineering process.

This topic walks you through the steps to forward engineer a MongoDB model. Similarly,
you can forward engineer a model to your Cassandra Keyspace and Couchbase Bucket.

To forward engineer a model:

1. Open your MongoDB model in erwin Data Modeler (DM).
Note: Ensure that you are in the Physical mode.

For example, the following image uses a MongoDB model with two collections.

” ObJECtS Ccunt J‘l *
El'“"i]l, Inc. IThe Customer MNumber was | ”S’D‘C —_— numb‘e; = A Mame: EMOVIES 2021R.1 (MOVIE)
o # 5
erwin Sample Diagram  [FIS1=m=d 1 prevent unification. | [ isanexamplect Type: Logical/Physical
N . v MK migration ; . X
eMovies.erwin o A View Mode: Physical
" MOVIE —
CUST_CREDIT CUST .
= - Subject Areas: 0 Indexes: 2
CUST_number CUST_number movie_nurmber
= Colections: 1 Relationships: 0
cradit_cand CUST_address movvie_tile P
credit_card_sp CUST ciy movvie_direchor Fields: 35
status_cads CUST_first_rame dezcription
S PAYRENT CUST last_rame star_1_name
Al CUST_stae rating
payment_transaction_number CUST_ zip_code Star_2_name : .
papmEnt_type email genre Style:  Pie Style (30) - Pallete: vibrant!
payment_amourt 5 PAYRAENT renta_l_rane
paymeant_dae Al mowvie_ul
payment_staius payment_transaction_rumbsr movie_cip
check_bank_numbes Payment_tpe 5 hONIE_STORE
check_numbss payment_amaourt ¥ (o] .
epay_wendor_number payment_dabe movie_nurmber
epay _account_nurmber papment_stius . store_number
credit_card_nurmbes check_bank_numbs 5 hADNIE_COPY f
credit_card_ap chack_number " ¥ o 5
credit_card_ppe epay_wendor_number general_condition A
EtAP_number epay_account_nurmbes e _fomret
customer na eredit_card_nurmber Mo _Go_num
CUST_number credit_card_ep i _nurmber
MO RENT REC credit_card_bpe - k0_RENT_REC w
it - ERF number o
< >

\Drawing ObjectsAPhysical with Vims/(Attribute."Column Display/ Properties | Objects Count

2. Click Actions > Schema.
The Forward Engineer Schema Generation Wizard appears.
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B Forward Engineer 5chema Generation Wizard [m] >

Schema Generation Overview
This page provides an overview of the Forward Engineer Schema Generation.

Overview

Option Selection

‘Welcome to the Forward Engineer Wizard. This wizard lets youforward engineer a model.
Collection Filter
Forward engineering is the process of generating the physical database schema from a physical model. You use the
Preview Schema Generation wizard to forward engineer a model and generate the schema. The schemathat you generate
includes alloptions that aresupported in yourtarget server. You can customizethe generated schemaforyour
target server using features inthe Schema Generation wizard.

The Option Selection page lets you customize the Schema Generation option set and the database template.

The Summary page lets youraviewths selected SchemaGeanaration options in a hierarchical tree structure, The
page also lets you enter a commentforthe current Schema Generation option set.

The Owner Override page lets you enterthe owner override name of an object group. The object group and
name you indicate overridethe owner name assignment for that objectgroup inthe model.

The Collection Filter pageletsyou selecta subset of the tablesin amodel forforward engineering.

The Preview page lsts youpreview the schema DDLscript generated forthecurrent model.

<Back Next > Generate ok || cancel || Hep |

3. Click Option Selection.

The Option Selection section displays the default option set. Clear the Drop check
boxes and select other syntax check boxes as required.

34



|87 Forward Engineer Schema Generation Wizard

Schema Generation Options

This page allows the user to change the Forward Engineer Schema Generation Options.

Option Set: | Defait NoSOL Schema Generation

Datsbase Template: | MongaDB. fet

| [ome | o] [rest ]

Collection Filter

General Syntax Option
Preview

[ use DB [Jcomments [ Blank value

Collection Syntax Option

[ create orop M insert

View Syntax Option

[ creats [Drap

Index Syntax Option

E Create @Drop

User Syntax Option

[creats Corap

[ 5chema validation

< Back || Mext =

Generate ok || cancel || Hep |

Click Next.

The Collection Filter section appears. It displays a list of collections available in your

model.
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|87 Forward Engineer Schema Generation Wizard

Schema Generation Collections Filter
This page allows the user to change the filter on the Forward Engineer Schema Generation Collections.

Owerview
| % 0 22
Option Selection
PIH cusT
EAE cusT_creptT
Preview [ MOVIE
------ M sTore
4 selected, 4 shown

| < Back || Mext = | Generate

5. Select the collections that you want to forward engineer.
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6. Click Preview to view the schema script.

|7 Forward Engineer Schema Generation Wizard O X
Forward Engineer Schema Generation Preview
This page provides a preview of the Forward Engineer Schema Generation,
- Clauto Brorchec
O e Viewer Text
Collection Filter 1 use eMoviesTechPubs ;I "
2{ db.createCollection("HMOVIE");
3 db.MOVIE.insert|(
4l {
5 "movie number": 0,
& "movie title": "7,
7 "movie director™: "',
B "description": "V,
] "star_ 1 name": "",
10 "rating™: "",
11 "star_2Z name": "",
12 "genre": "W,
13 "rental_rate": O,
14 "movie_wurl": ",
15 "movie clip": BinData(O," "),
16 "MOVIE STCRE": [
17 {
B "movie number": O,
1s "store_number": 0
20 }
21 1.
224 "MOVIE_COPY": [
23 {
24 "general condition™: ",
25 "movie format": "7,
26 "mo_co_num": O,
27 "movie number™: O,
3 RI- nMO GRNT RECT. T N
< >
< Back Next > Generate | [ ok || concel || Heb

Use the following options:

o Auto Error Check: Select this option to enable auto error check by the forward
engineering wizard.

e Error Check ( & ): Use this option to run an error check. Based on the results,

you can correct the generated script.

« Text Options (i4): Use this option to configure the preview text editor's look
and feel, such as window, font, syntax color settings. For more information,
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refer to the Forward Engineering Wizard - Preview Editor topic.

« Save (E): Use this option to save the generated script in the JSON or BSON
format.

7. Click Generate.
The forward engineering process starts. The script generates your physical database
schema. You can access your database and verify the newly generated schema.
3 C : O X

(= NEEIE: SRE

"rental_record_date”: new Timestampi), ~
"soc_sec_number": 0,

"EMP_phane": 0,

"mo_co_num™: 0,

"movie_number": 0,

"CUST_number": 0,

"payment_transaction_number": 0

}
01
H

Execution Successful

Schema Generation Complete
9 query succeeded.

| Stop i Fail
op i raiure Save Data... oK Pause

Comparing Changes using Complete Compare

You can compare your model with database, script, or another local model to check for dif-
ferences using the Complete Compare wizard. Based on the results, you can then resolve or
merge differences. Thus, maintaining a consistent model and database.

This topic walks you through the steps to compare a MongoDB model with database. Sim-
ilarly, you can compare your Cassandra and Couchbase models.

To compare models with database:

1. Open your MongoDB model in erwin Data Modeler (DM).
Note: Ensure that you are in the Physical mode.
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For example, the following image uses a MongoDB model with two collections.

eMoviesDoc.erwin -~ X

-

CUST

_id

CUST_number

CUST address

CUST ity

CUST first_name

CUST last_name

CUST state

CUST_zip_code

email

S PAYRENT

v
payment_transaction_number
payment_type
payment_amaount
payment_date
payment_statuz
check_bank_number
check_number
epay_wendor_number
epay_account_number
credit_sard_number
credit_card_sup

<
% ER_Diagram_118 /

CUST_CREDIT

_id

CUST_number

wredit_card

wredit_card_eup

status_code

B PAYRENT

v
payment_transaction_number
payment_typs
payment_amount
payment_date
payment_status
check_bank_number
check_number
epay_wendor_number
epay_account_number
credit_card_number
credit_card_esqp
credit_card_type
ERAP_number
customer_

Ll
RATING

stars
reviet

MOVE
_id
movie_number
moie_title
moevie_directar
dezeription
star_1_name
rating
star_Z_name
genre
rental_rate
mavie_url
mavie_clip

= MOWIE_STORE
v

Objects Count 4 x
Mame: MODEL_&
Type: Logical Physical
View Mode: Physical
Subject Areas: 0 Inde
Collections: 5 Relz
Fields: 213
Style:  Pie Style (30) -

Properties | Objects Count

2. Click Actions > Complete Compare.

By default, the Complete Compare wizard assigns the open model as the Left Model.

Hence, the Right Model section appears.

Right Model Selection

Select the Right Model

Left Model

Advanced Options

Load Session...

Save Session...

Flease select a model for the right side of complete compare.

Load From

(®) File

(C) Database / Script

Open Models in Memory:

Compare Level:
Database

O Mart

Load...

Open Models Location

ki [Model 6

C:\Jsers\adminlerwin, Inc{Technical Publication. ..

[[]5et selected model as read only

| Mext = |

< Back Compare

Close Help
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Click Database/Script.
By default, the Allow Demand Loading option is selected.

Right Maodel Selection x
Select the Right Model Compare Level:
Please select a model for the right side of complete compare. Database

Load From

(IFile (®) Database / Script (") Mart
Allow Demand Loading

Open Models in Memary:

Open Models Location

@ Model_& C:\Users\admin‘erwin, Inc\Technical Publication. ..

[] set selected model as read only

Load Session... Save Session. .. < Back | Mext = | Compare Close Help

Click Load.
The New Model dialog box appears. This starts the reverse engineering process to pull
a model from the database to compare.
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Mew Model *

Type
Logical  ( JPhysical (@) Logical/Physical () Match template

Target Server

[IMatch template target server

Database: | MongoDB w~ | Mersion: |4,x R

Template

<Default= i | @ @

Preserve the template binding

2

5. Ensure that the Database is set to the correct one. In this case, MongoDB. Then, click
Next.

The Reverse Engineer Process Wizard appears.
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|87 Reverse Engineer Process Wizard | *

Reverse Engineer Process Overview
This page provides an overview of the Reverse Engineer Process,

Reverse Engineer From

() Script File
ile: Browse...
Database - =
Collection .
Overview ~
Option Set . } S ] -
Welcome to theReverse Engineer Wizard. Thiswizard lets you reverse engineerfram the physical
Detzil Options database.
Scheduler Reverse engineering is the process of generating the physical database schema from a physical
= maodel. You can customizethe Reverse Engineer foryourtarget serverusing features in the Detail
options.
The Option Set page |ets you customize the Reverse Engineer option s&t.
The Scheduler page lets vou customize the Reverse Enginaer Scheduler options. The page dso
lets youuse Complete Compare and Martfor thetarget location.
The OwnerOverride page lets you enter the owner override name of an object group. The object
group and name youindicate override the owner name assignment forthat abject group in the
model.
The Collection Filter pagelstsyouselect asubset of the tablesin a modelfor Reverse
engineering.
The Preview page lets youpreviewthe schema DDL script generated forthecurrent model. [¥]

< Back ok || cancel || Hep

6. Click Database. Then, click Next.

The Connection section appears. Use this section to connect to the database from
which you want to reverse engineer the model.

7. After connection is established, click Next.
The Database section appears. It displays a list of available databases.
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[ Reverse Engineer Process Wizard O *

Database Selection Options
This page allows the user to select available database list.

[]System Objects

Available Databases: Enter fiter fext Selected Databases:

_Mongo_Collation_01 (4)
_Mongo_Collation_Comment (3)
Caollection dbname {3)

eMoviesDoc (4)
eMoviesTechPubs (4)
Detail Options financial {5)

s cheduler MongaDB_View_01 {1)
newDB (2)
sample_airbnb (2)
sample_analytics (3)
sample_geospatial (1)
sample_mflix (5)
sample_supplies {1)
sample_training (12)
sample_training_test (1)
sample_weatherdata (1)
test (3)

Option Set

0 e el

Ttems: (17) Items: (0}

| <Back || Mext> | [ ok ]| concel || reb |

Under Available Databases, select the databases that you want to reverse engineer.
Then, click |E¥.
This moves the selected databases under Selected Databases.
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[ Reverse Engineer Process Wizard O *

Database Selection Options
This page allows the user to select available database list,

[ system Objects

Available Databases: Enter filter fext Selected Databases:

_Mango_Collation_01 (4) eMaviesDoc (4)
_Mango_Collation_Comment (3)
Collection dbname (3)

eMoviesTechPubs (4)

finandial (5)

Detail Options MongoDB_View_01 (1)
Scheduler newDEe (2)

sample_airbnb (2)
sample_analytics (3)
sample_geospatial (1)
sample_mflix (5)
sample_supplies (1)
sample_training {12)
sample_training_test (1)
sample_weatherdata (1)

test (3)

Option Set

Gl ¥

@ (@]

Items: (16) Items: (1)

| <gack || Nedt> | [ o || concel || nep |

Click Next and in the Collection section, click .
This selects all the available collections. Also, ensure that the Document Coun-
t/Document % is not set to zero (0).
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[ Reverse Engineer Process Wizard O X
Collection Selection Options
This page allows the user to select available collection list.
Sampling
Document Count w | | 4 | []Deep Search (@) Sequence (_)Random
Available Collections: Enter fiter text Selected Collections:
Hcust (2
 cusT_CRrEDIT (2)
Hmovie (2)
Option Set H sTore (2)
Detail Options <:I
Scheduler
Ttems: (0) Ttems: (4)
| <Back || MNext> | [ ok || cancel || Hep |

10. Click Next and in the Option Set section, keep the default configuration.
11. Click Next and in the Detail Options section, keep the default configuration.

12. Click OK.

The reverse engineering process starts. Once the process is complete, the Right Model
is set to the one that you reverse engineered.
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Right Model Selection

Select the Right Model Compare Level:
Please select a model for the right side of complete compare. Database

Load From

(I File (®) Database | Script (I Mart

Allow Demand Loading

Open Models in Memory:

Open Models Location
'@ Model_14 doud.mongodb: () .+ (MongoDB 4.x)
'i'a Madel_& C:\Users'admin'erwin, InciTechnical Publication...

[]set selected model as read only

Load Session... Save Session. .. < Back Mext = Compare Close Help

13. Click Next and in the Type Selection section, select the appropriate options.
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14.

For example, the following image shows the default options.

Type Selection

Complete Compare Type Selection Compare Level:
Flease select the types of objects to be compared in complete compare. Databasze

Compare Level
[JLogical Level [Jprhysical Level Database Level

Option Set: | Speed Option Set v | = |

D
=

[£] Properties
]+ collection
(1[7] Database
EH Relationship
C]i&, User1d
-] () view

Advanced Options

Load Session. .. Save Session. .. < Back | Mext = | Compare Close Help

Click Next and in the Left Object Selection section, select the appropriate options.

47



For example, the following image shows the default options.

Left Model Object Selection *
Left Model Object Selection Compare Level:
Please select the objects you want to compare from left model, Database

Choose Objects Using Sets Selected Objects:
[ERME(IE] subject Areas = [ Model_s

= ﬁ Indexes E Collections
ﬁ COwned By

Advanced Options

[JHide unselected objects

Load Sessian... Save Session. .. < Back | Mext = | Compare Close Help

Click Next and in the Right Object Selection section, select the appropriate options.
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For example, the following image shows the default options.

Right Model Object Selection *
Right Model Object Selection Compare Level:
Please select the objects you want to compare from the right model. Database

Choose Objects Using Sets Selected Objects:
Mg subject Areas B--- [ Model_14
Overview A= Indexes -] B collections

ﬁ COwned By

Left Model

Right Model

Advanced Options

[JHide unselected objects

Load Session. .. Save Session. .. < Back | Mext = | Compare Close Help

16. Click Compare.
The comparison process runs, and the Resolve Differences dialog box appears. It dis-

plays the differences between your model and database.
For example, the following image shows that the Rating collection is available in your

model but not in the database.
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B Resolve Differences O >

G| be | B2
g8 B

CRAY
=L #FEH
= = | 38
Object View ‘@ Model_6 - C:WUsers\adminierwin, InciT... ‘@ Model_14 - doud.mongodb: (avinashm):...
B [ Model Model_5 IEY Model_14
Bl B3 Collections Ll
H collection &£ cusT €IE» cusT
HHcollection & CUST_CREDIT B CUST_CREDIT
H collection 2 MoviE &Ey MoviE
Bl H collection £ RATING X
Bl B2 Fields
Field $ review
Field $ stars

Collection ___L.0| STORE

Property View ‘@ Model_6 - C:WUsers\adminierwin, InciT... '@ Model_14 - doud.mongodb: (avinashm):...
5] Database Field Order Z& _id,store_number,store_manager, store_addr... 4B i R e

R
S S S

ﬁField Order $ _id,store_number ,store_manager,store_addr... {,‘EI@

Select the Rating collection and click E> . This will move the Rating collection to the
right model (from the database). Similarly, resolve other differences.

17. As differences were moved to the right model, click .
This launches the Forward Engineering Alter Script Generation Wizard.
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18. Click Option Selection and clear all the Drop check boxes.

B Forward Engineer Alter Script Schema Generation Wizard O b

Schema Generation Options
Thig page allows the user to change the Forward Engineer Schema Generation Options.

Option Set: |Selectﬂ’1eopﬁonsﬁ>rDBS'mc V| | Open... | | Save | | Save As... | I:

Database Template: |M0ngoDB-Fet | | prowse... | | Edt.. || Reset |

Collection Filter

General Syntax Option
Preview

[ comments [ Blank value

Collection Syntax Option

[~ create orop [ Insert [ schema validation

View Syntax Option

@ Create |:| Drop

Index Syntax Option

E Create |:| Drop

User Syntax Option

|:| Create |:| Drop

| <Back || mMext> || Geneat= [ ok || cancdl || Hep |

19. Click Collection Filter and select or verify the collections to be included on the for-
ward engineering script.
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20.

21.

22.

23.

" Forward Engineer Alter Script Schema Generation Wizard

Schema Generation Collections Filter

This page allows the user to change the filter on the Forward Engineer Schema Generation Collections.

[¥]H eMoviesDoc. CUST_CREDIT
] eMoviesDoc. MOVIE
------ [ H eMoviesDoc, STORE

5 zelected, 5 shown

| < Back || Mext = | Generate

|| Cancel

Help

Click Preview to view and verify the alter script.

Click Generate and connect to your MongoDB database.
The forward engineering process starts. The script generates your physical database

schema. You can access your database and verify the newly generated schema.

Click OK. Then click Finish.

This closes the Resolve Differences dialog box and displays the Complete Compare wiz-

ard.

Click Close.
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JSON and AVRO Support

erwin Data Modeler (DM) now includes modeling support for JSON and AVRO file formats.

The following table lists the supported objects and data types for each format:

File
Objects Data Types
Format
JSON ® JSON Objects " Object
" Fields " Array
" Relationships| = |pteger
" Null
® String
®= Number
® Boolean
AVRO ® Records " Array
® Fields ® Boolean

® Relationships ® Union
" Map

" int

" Double
® QObject
® String
® Byte

" enum
® Fixed

" Long
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https://erwin.com/bookshelf/public_html/2021R1/Content/User Guides/erwin Help/JSON_Support_Summary.html
https://erwin.com/bookshelf/public_html/2021R1/Content/User Guides/erwin Help/Avro_Support_Summary.html

Similar to relational or NoSQL databases, JSON and AVRO as target databases support:

® Reverse engineering models from scripts

" Forward engineering models

Reverse Engineering Models - JSON and AVRO

You can create a data model from JSON and AVRO scripts using the Reverse Engineering pro-
cess.

Note: For reverse engineering German language JSON scripts, ensure the script Encoding is
set to Convert to ANSI.

This topic walks you through the steps to reverse engineer a JSON model from a script file.
Similarly, you can reverse engineer a model from your AVRO script file.

To reverse engineer a model:

1. In erwin Data Modeler (DM), click Actions > Reverse Engineer.
The New Model screen appears.

Mew Model *
Type
Logical  (O)Physical (@) Logical/Physical () Match template

Target Server
[IMatch template target server
Database: | 150M | Mersion: | 1.x w

Template

«Default= ™ | @ @

Preserve the template binding

2. Click Logical/Physical and set Database to JSON.

3. Click Next.
The Reverse Engineer Process Wizard appears.
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B Reverse Engineering Wizard OJ X

Overview
Reverse Engineering options overview

Reverse Engineer From

Detailed Options Database (O Json Data (®)5chema File
File: ‘ C:\Users\ArunnShampath\erwin, Inc\Tecl‘ ‘ Browse...
Scheduler
Overview

‘Welcome to the Reverse Engineering Wizard!

The Ry ngit ing wizard wall he process of reverse engineeris delfrom aphysical database.Youcan
customize the operation for atarget database of your choice using the several option sedions available.

Detailed Options: Use this section to configure detailed reverse engineering options, such as NSM options, objeds to be reverse
engineered, primary keys and relations inference, physical and logical name case conversions, and trigger indusian.

Scheduler: Use this section to configure the model and martlocation for the reverse engineering job being scheduled.

< Back Next > | OK | ‘ Cancel | ‘ Help |

4. Select Json Data or Schema File format option. Then, click Browse and select one or
multiple script files.

5. Click Next.

The Detail Options section appears. Set up appropriate options based on your require-
ment.
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|7 Reverse Engineer Process Wizard

Reverse Engineer Detail Options
This page provides a Detail Options of the Reverse Engineer Process.

M5M Options

Glossary C5V File: | | Browse...

Reverse Engineer

System Objects
RecordsMiews Owned By
Al () Current User
() Owners (comma separated):

s From
[ erimary Keys Indexes
[ Relations Names

Case Conversion of Physical Names
@ none (lower (JUPPER [ |Force
Case Conversion of Logical Mames

@®nNone  Olower (JJUPPER () Mixed

| Indude Generated Triggers

< Back || Mext =

6. Click OK.

57



The reverse engineering process starts.

Reverse Engineer From Script

Script Mame: | C:\Wsers\adminterwin, Inc¥Technical Publications Team - erwin Data Modeler and Mz
(=] Reverse Engineer

Cancel

e

Modell2 X

academic_catalogs 1500

academic_credentials 150

<)
Once the process is complete, based on your selections, a schema is generated, and a
model is created.

~ Mame: MODEL_12
Type: Logical/Physical
academic_disciplines 150 View Mode: Physical
title title title
deseription description deseription Subject Areas: 0 [inde
type type type .
¥ properties ¥ properties ¥ properties EikE i w1
¥ metadata ¥ metadata ¥ metadata Columns: 3113 []subd
titl title: title
dezcription desoriptice descripticn
type — type tpe
¥ properties properties ¥ properties . .
¥ createdBy ¥ created By ¥ createdBy Style: |Pie Style (30)
title title title:
desaription descripticn desaription
type type type
¥ createdh ¥ crestedOh ¥ created T
title title title
desaription descripticn desaription
= onelf £ aneCk = ohel /
v [ vl v |
type type type e
farmat farmat format 3113
pattem pattem pattam
¥ v
= Hine .
£
ER_Diagram_118 Properties | Objects Count
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Forward Engineering Models - JSON and AVRO

You can generate a physical schema from a physical model using the Forward Engineering
process and then, save it in the JSON and AVRO file formats.

This topic walks you through the steps to forward engineer a JSON model. Similarly, you can
forward engineer an AVRO model.

To forward engineer a model:

1.

Open your JSON model in erwin Data Modeler (DM).
Note: Ensure that you are in the Physical mode.

For example, the following image uses a JSON model with 16 tables.

Model12 X

-

academic_catalogs 150 academic_credentials 150 academic_disciplines_15.0
title: title: titler
deseription dezeription deseription
tvpe trpe type
¥ properties ¥ properties ¥ properties
¥ metadata ¥ metadata ¥ metadata
title: title: title:
description description deseription
type type type
¥ properties ¥ properties ¥ properties
¥ createdBy ¥ createdBy ¥ oreatedBy
title tithe tithe
deseription description dezeription
type type type
¥ created Ok ¥ createdln ¥ createdTh
title tithe tithe
dezcription dascripticn description
& onel¥ I one
¥ 0] ¥ v
type type type
format format farmat
pattem pattem pattem
v [1] MU ¥ [l
R, Hima .
£ >
% ER _Diagram_118 /

~

Objects Count 41 x

Mame: MODEL_12

Type: Logical/Physical

View Mode: Physical

Subject Areas: 0

Tables: 16 Relat
Columns: 3113
Style:  Pie Style (30) =
N

Properties | Objects Count

Click Actions > Schema.
The Forward Engineer Schema Generation Wizard appears.
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|87 Forward Engineer Scherna Generation Wizard O =

Schema Generation Overview
This page provides an overview of the Forward Engineer Schema Generation.

Overview

Option Selection

Welcometo the Forward Engineer Wizard. This wizard |ets youforward engineer a model.
Table Filter ) o ) ) )
Forward engineering is the process of generating the physical database schema from a physical madal. You use the
Ermoz Schema Generation wizard to forward engineer a model and generate the schema. The schema that you generate
includes all options that aresupported inyourtarget server. You can customizethe generated schemafaoryour
target server using features inthe Schema Generation wizard.

The Option Selection page lets you customize the Schema Generation option st and the database template.

The Summary page lets you review the selected SchemaGeneration options in a hierarchical tree structure. The
page also lets you enter a commentfaor the current Schema Generation option set.

The Owner Override page lets you enterthe owner override name of an object group. The object group and
nameyou indicate overridethe owner name assignment for that objectgroup in the model.

The Table Filter pageletsyouselectasubsetof thetablesin amodeal forforward enginzering.

The Preview pagelets youpreviewthe schema DDLscript gensrated forthe current model.

Generat= | ok || cancel || heb |

3. Click Option Selection.

The Option Selection section displays the default option set. Select appropriate syntax
options.
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m Forward Engineer Schema Generation Wizard O X
Schema Generation Options
This page allows the user to change the Forward Engineer Schema Generation Options
Option Set: |DeFadthSQ_Sd1a'naGa1eraﬁon V| | Open... | | Save | | Save As. | I:
Database Template: | JsonDE. fet | | Browse. .. | | Edit | | Reset |
Table Filter
General Syntax Option
Preview
Use DB [A comments [~ Blank value
Collection Syntax Option
Create Crop Insert Schema Validation
<§adc||uext> Generate || oK || Cancel || Help |

4. Click Next.
The Table Filter section appears. It displays a list of tables (JSON objects) available in

your model.
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" Forward Engineer Schema Generation Wizard O X

Schema Generation Tables Filter
This page allows the user to change the filter on the Forward Engineer Schema Generation Tables.

%G S

Preview

----- [ academic_period_enrollment_statuses_g.0
----- M academic_periods_16.1.0

----- [#]|8 academic_programs_15.1.0

----- [#*]|8 academic_standings_15.0

----- [*]|8 account_funds_available_10.0

----- [E account_funds_available_transactions_10.0
----- |8 account_funds_available_transactions_11.1.0
----- [EH accounting_code_categories_15.0

----- 1B accounting_codes_15.0

----- [1E accounting_string_component_values_15.0
----- EE accounting_string_components_15.0

16 selected, 16 shown Apply selection of Tables to Tablespaces and Databases

|<§adc||uext>|senerabe|u(||::ancel||Heb|

5. Select the tables (JSON objects) that you want to forward engineer.

62




6. Click Preview to view the schema script.

|87 Forward Engineer Schema Generation Wizard O X
Forward Engineer Schema Generation Preview
This page provides a preview of the Forward Engineer Schema Generation.
- [l Bror check
tion Selection
Op Viewer Text
Table Filter 1 /* [JSON Cbject:academic_catalogs_15.0] */ ~
2t 1
3 meitlem; e,
4 "description™: "",
5 neypem: nw,
= "properties™: {
7 "metadata™: {
8 neiglemy nw,
=] "description™: "7,
10 neypen: nw,
J._LE "properties™: |
1zf "createdBy™: {
13 mpiglemy mm,
14 "description": "",
15 neypem: mw
16t~ T
174 "createdCm": {
8 neitlem: e,
19 "description": "",
20 "oneQf": [
21 {
23 neypen: nw,
23 "formatn: "M,
24 "pattern": ""
25 by
26 {
27 neypen: "m,
78 PmawTenarh®- 0 ¥
£ >
<Back Next Geerate | [ ok || cancel || Hep

Use the following options:

o Auto Error Check: Select this option to enable auto error check by the forward
engineering wizard.

o Error Check ( & ): Use this option to run an error check. Based on the results,

you can correct the generated script.

« Text Options (i4): Use this option to configure the preview text editor's look
and feel, such as window, font, syntax color settings. For more information,
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refer to the Forward Engineering Wizard - Preview Editor topic.
« Save (A): Use this option to save the generated script.

7. Click Generate.
The following screen appears.

Save Forward Engineering Script x
Databaze 150N w
Set Path | C:\Wsers\adminiOneDrive - erwin, Inc\Documents\M

Generate File Options

[] Generate Multiple Files [ File Mame Prefix :

Save Close

8. Use the following options:
= Set Path: Use this option to set the location to save the script file.

® Generate Multiple Files: By default, a single script file is created. Select this
option to save the script into multiple files by objects.

® File Name Prefix: Select this option to add a script file name. Enter a file name.

If this option is not selected, the script file is saved with a default name (Erwin_
FE_Script.json).

9. Click Save.

Your script file is saved at the configured location. You can open it in any text editor
and verify.
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Oracle Support Summary

erwin Data Modeler (DM) now supports Oracle 12c R2, 18c, 19¢, and 21c as target data-

bases. This implementation supports the following objects:
® Cluster
® Column
® Comment
® Context
® Database
® Database Link
® Directory
" Disk Group
® Function
® Index Editor for Clusters
® Index Editor for Materialized Views
® Index Editor for Tables
" Library
® Materialized Views
® Materialized View Log
® Package
® Package Body
® Pre and Post Scripts
® Rollback Segment
® Sequence
® Stored Procedure

® Synonym
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Table

Tablespace
Tablespace Group
Trigger

Views

The following table lists the supported data types:

Numeric String Literals Date and Time Other

« BINARY_ « CHAR o DATE JSON*
DOUBLE ANYDATA

« CHAR() o INTERVAL

« BINARY_ CHARVARYING DAY TO ANYDATASET
FLOAT * () SECOND ANYTYPE

« DEC » CHARACTER o INTERVAL BFILE

. DEC() o CHARACTER() YEAR TO

MONTH BLOB
DEC() « CHARACTERVARYING
’ 0 o TIMESTAMP LONGRAW
« DECIMAL . CLOB « TIMESTAMP ORDAUDIO
« DECIMAL() WITH LOCAL
« DBURITYPE TIMEZONE ORDDICOM

« DECIMAL(,)

« URITYPE . TIMESTAMP ORDDOC

o DOUBLE WITH

e HTTPURITYPE ORDIMAGE
PRECISION TIMEZONE
e JSON ORDVIDEO

« REAL o TIMESTAMP
FLOAT » JSON() () RAW()

. FLOAT() « LONG o TIMESTAMP SDO_GEOMETRY
INT o NATIONAL CHAR f_)OVg/I-\TLH SDO_GEORASTER
INTEGER « NATIONAL CHAR TIMEZONE SI_AVERAGECOLOR

VARYING() TIMESTAMP SI_COLOR

« NUMBER ° -

« NATIONAL CHAR() () WITH
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« NUMBER()
« NUMBER(,)
« NUMERIC

« NUMERIC()

« NUMERIC
()

e ROWID

e SMALLINT

NATIONAL
CHARACTER

NATIONAL
CHARACTER
VARYING()

NATIONAL
CHARACTER()

NCHAR
NCHAR VARYING()
NCHAR()

NCLOB
NVARCHAR2()
UROWID
UROWID()
VARCHAR()
VARCHAR2()
XDBURITYPE

XMLTYPE

TIMEZONE

Sl
COLORHISTOGRAM

SI_FEATURELIST

Sl
POSITIONALCOLOR

SI_STILLIMAGE

SI_TEXTURE

*This datatype is supported only for Oracle 21c.
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Microsoft SQL Server Support

Support for Microsoft SQL Server 2019 as a target database has been enhanced to imple-
ment the following objects:

® External Library
® External Language

" External Data Source

External File Format
" External Table
® Statistics

For detailed information on supported objects and data types, refer SQL Server support sum-
mary.
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Microsoft Azure SQL Server Support

Microsoft Azure SQL support in erwin DM has been revamped. It is now supported on top of
Microsoft SQL Server to leverage common functionality. On the New Model and Target Data-
base dialog boxes, you can find Azure under SQL Server Version drop-down list.

erwin Data Modeler -- Target Server >
Database: SCL Server ~ | 50L Server Version | 2019 e
2012
Default 42014
2016/2017
char(13
Auto Mormalization (182015
Mull O
Relationships () NOT NULL
(@) MULL
Cancel

The following table lists the supported objects:

Supported Objects

o Always Encrypted o Resource Pools*

Keys
Schemas

o Application Roles
e Sequences

e Assemblies* )
o Server Audits*

e Asymmetric Keys .
o Server Audit Spe-

« Certificates cification*

o Credentials* « Statistics

o Database Roles o Stored Procedures
o Databases o Symmetric Keys

o Database Triggers o Spatial Indexes (Table)

o External Data e Synonyms
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Source o Tables

o External File e ColumnStore Indexes
Format* (Table)

o External Library* e XML Indexes (Table)
o External Table o Indexes (Table)

o Full-Text Catalogs o Table Triggers

o Full-Text Indexes o Triggers
(Table)
e Userlds
o Full-Text Stoplists ]
e Views
o Functions .
o View Indexes
e Logins

o View Triggers
e Partition Func-

. e XML Schema Col-
tions

lections
e Partition Schemes

* These objects are supported only for Azure SQL Managed Instance.

The following table lists the supported data types:

Exact Approx-| Date and | Char- |Unicode | Binary Geo Types Others
Numerics |imate Time acter |Char- Strings
Numer- Strings |acter
ics Strings
o bigin- o fl- o date o Ch- e NC- o bin- e rowver- o
t o- ar har ary sion CHA-
o dat-
at ) hi R
. nu_m- e]’:cme- e vai e nNv- . \t/)?r- . |eL- y VAR-
eric o red offset rc- arc in- archyi YING
bi al q h- har ary o
e DIt . 3t- , ar t . . ;nlquel- « CHA-
etime e nNt- e im- en-
e smal- - RAC-
o te- ext age tifier
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lint

deci-
mal

small;
mon-

ey
int

tiny-
int

mon-
ey

e smalld-
ate-
time

e dat-
etime

o time

xt

sql_vari
ant

xml

geo-
metry

geo-
graphy

TER

CHA-
RAC-
TER

VAR-
YING

NATI-
ONA-

CHA-

VAR-
YING

NATI-
ONA-

CHA-

NATI-
ONA-

CHA-
RAC-
TER

NATI-
ONA-

TEXT
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MySQL Support

erwin Data Modeler (DM) now supports MySQL 8.x as a target database. This imple-
mentation supports the following objects:

® Database
® Event
® Function
® Function_UDF
® Logfile Group
® Server
® Spatial Ref System
® Stored Procedure
® Table
" Index
® Table Column
" Tablespace
" Trigger
® UserID
® Validation Rule
" View
® View Column

The following table lists the supported data types:

Numeric String Literals Date and Time Other

o TINYINT o CHAR o DATE o Geometry Type

e SMALLINT o VARCHAR o TIME o POINT

e« MEDIUMINT o BINARY o DATETIME e LINESTRING

e INT, o CHARBYTE o TIMESTAMP o POLYGON
INTEGER o YEAR e« MULTIPOINT
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. BIGINT « VARBINARY « MULTILINESTRING
« DECIMAL, « MULTIPOLYGON
DEC, « TINYBLOB « GEOMETRYCOLLECTION
NUMERIC, . BLOB « GEOMETRY
FIXED
e FLOAT e BLOB and
o DOUBLE, TEXT Data
DOUBLE Types
PRECISION, | | MEepiuMBLOB
REAL
. BIT . LONGBLOB
e TINYTEXT
o TEXT

e MEDIUMTEXT
e LONGTEXT

e JSON Data
Type

e ENUM

o Set Data Type

Note:

® Refer to MySQL database documentation for detailed information on specific MySQL
objects and properties. erwin® Data Modeler documentation for the property editors
provides brief descriptions of the controls on each dialog box and tab, which you can
use as a point of reference while working with database design features.

® As a best practice, use the MySQL ANSI ODBC driver for Reverse Engineering from
Database (REDB) while using erwin® Data Modeler
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Data Vault 2.0 Support

erwin Data Modeler (DM) now Data Vault 2.0 as a modeling technique across all target data-
bases. This implementation supports the following Data Vault 2.0 components by default
through API:

" Hub
" link

Satellite

Reference
" PIT
" Bridge

These components are available on Home tab of the ribbon.

¥ erwin DM - [JSOMMeodelForFE.erwin : ER_Diagram_118] — (] »

View Diagram Model Mart Actions Tools Help Options ™ - 0 X

==] " !dentifying @ ¥ Cut ' HGoTe.. | @Hb OPIT
— 1. Non-ldentifying O Copy L Q Find @Link U‘Reference
Model JSON : Shapes Paste Select Fo T, .
Templates - Object [=] Annotation T Delete } i+ Replace §| == Bridge 48 satellite

Teolbox Drawing Clipboard Editing Data Vault 2.0

To enable Data Vault 2.0 on your model, follow these steps:

1. Right-click the model and click Properties.
2. On the Model Editor > General tab, select the Data Vault 2.0 check box.
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B Model 'EMOVIES 2021 R1" Editor ] X

General Defaults RI Defaults History Options Definition UDP  History Notes Extended Notes

Model Information

Name H FMOVIFS 2021 Rf
Author 1 | erwinTeam
Type: Logical / Physical Target Server And Version: SQL Server 2019
Notation
Logical Notation ;| | TnEF1v 4
Physical Notation || | 1nFF1v v
Modeling Features
Is Dimensional  |; [[]
Data Vault 2.0 | [
Data Movement || |[]
| Close | ‘ Cancel
| Details...| /

Once enabled, Data Vault 2.0 components are available via the Model Explorer. You
can now convert your model to a Data Vault model.

You can also create custom components and apply them to tables. However, these
custom components do not appear on the ribbon.
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Productivity and Ul Enhancements

Several additions and enhancements have been implemented to improve erwin Data

Modeler's (DM) productivity and usage experience. These enhancements are:

Welcome Page

Objects Count Pane

Properties Pane

Object Browser

Normalization and Denormalization

Reverse Engineering and Forward Engineering Wizard Redesign

Improved Speed Mode

Welcome Page

The Welcome page is a starter page that helps new users to get started with erwin DM. It
appears when you launch erwin DM and is also accessible via Help > Welcome. It contains
shortcuts to key actions that are performed frequently, such as opening models or creating
new ones, running reverse engineering or complete compare wizards, and connecting to the
Mart. Apart from these, the Welcome page provides access to recently used files, erwin DM
Tools, Technical Support, and Help links.
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m Welcome

erwin

yQuest

FILE ACTIONS

MODEL ACTIONS

+ Create New Model
D Create a new document

Open Existing Model
Open an existing document

RECENT FILES

Complete Compare
= Invoke Complete Compare
@ Reverse Engineer

——mll Reverse Engineer from a SQL Script or Di

TOOLS

EE Oracle21c.erwin

C:\DataModels

E_E SQS2012.erwin
C:\DataModels

DO YOU KNOW!

Import

Import from External Format

erwin DM Scheduler

Invoke erwin DM Scheduler

Options

Launch the Options Dialog

erwin Data Modeler is offered as a native 64-bit application with access to sufficient memory to complete operations on large models

Do not show this dialog again
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Objects Count Pane

As data models become complex and large, it becomes necessary to get a snapshot of the
objects within models. To facilitate this, erwin DM now includes an Objects Count pane. This
pane displays information about a selected model and a count of all the objects present in
it. Also, it displays a snapshot of this information in the pictorial format, which you can cus-
tomize using the Style and Pallete options. By default, this pane opens on the right-side of
the application. You can also access it via View > Panes > Objects Count Pane.

Objects Count B Xx

@

Name: EMOVIES 2021 R1
Type: Logical/Physical
View Mode: Physical

Subject Areas: 4 Indexes: 30 Views: 2

Tables: 9 Relationships: 20

Columns: 75 Databases: 0

Style:  Pie Style (3D) ~ Pallete: Illustration ~ Legend

Properties | Objects Count

Properties Pane

While working on data models, accessing the property editors to view or edit the model and
its object's properties can get tedious and slow you down. To address this, erwin DM now
includes a Properties pane. This pane enables you to view and edit the selected object's
properties along with the model diagram, side-by-side. By default, this pane opens on the
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right-side of the application. You can also access it via View > Panes > Properties Pane on
the ribbon.

Properties ax
o= B 2 B
4 General )

Name EMOVIES 2021 R1

Author erwinTeam

Definition

Logical Notation IDEF1x

Physical Notation IDEF1x

Current ER Diagram Drawing Objects

Current Subject Area

Current DSM Option Set eMovies

Current NSM Option Set eMovies.nsm

Allow Manual Relationship Layout v

Unigue Names Not Unigue

Is NSM Option From AMT
4 Defaults v
Properties | Objects Count

Object Browser

The Object Browser is a one-stop location where you can view tables, views, materialized
views, indexes, relationships, and the complete model's or specific table's DDL. You can
export this information as a report in CSV, HTML, or PDF formats. To access the Object

Browser, on the Properties pane, click E or on the ribbon, click Tools > Object Browser.
For more information, refer to the Object Browser topic.
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Object Browser

@ a. fivi @ E\ | Enter Seardh Text Tables: (25) Views: (4) Materialized Views: (1) = fivi 'r:‘|_‘1
= BookAuth A | |B Summary 1
H Stor_Mam Tables 26 2; CRERTE T&E
= Purchase Ordr Columns 138 s
= Rylty Views a 4 Auth I
) £ Book T
H Disc Materialized Views 0 & PRIMARY K
= Job Indexes 54 7. FOREIGN KE
(= Publshr_Logo Index Members 73 g FOREIGHN EE
= Emp Relationships a4 o)
B Auth Domains 22 -
= Publshr . b E2ealERE BL
E Subject Area 12
E Book Current Subject Area 13 COMMERT O
= Ordr_ltm W <
T T T T T T
w ) Index ... | i T... ¢ sl Index ... | 34 Order 1 Owner... | “ || %] Relationsh... | 34 Type s Parent i
UPKCL_taind PK Auth_Id Ascending BookAuth R/53 Identifying Ordr_Ship Bk
UPKCL_taind  PKE Book_Id Ascending BookAuth Rj44 Derived Pmt Pz
auidind IF Auth_Id Ascending BookAuth Rf33 Subtype Pmt Pe
titleidind IF Book_Id Ascending BookAuth R./f45 Derived Personal_Chk Pz
UPK_storeid PE Stor_Id Ascending Stor_MNam R/39 Subtype Pmt M
¥IF15tore_... IF Rgn_Id Ascending Stor_MNam R/43 Derived Mony_Qrdr Pz
UPKCL_sales  PK Qrdr_Mbr Ascending Purchase_... R/54 Mon-Identifying Crd_Card Cr
¥IF2Purcha... IF Cust_Id Ascending Purchase_... R/40 Subtype Pmt Cr
¥IF1Purcha... IF Stor_Id Ascending Purchase_... Rf42 Derived Crd_Card Pz
¥PERovalty PE Rylty Id Ascending Rylty i R/47 Derived Cust Pz
Indexes: (54) Index members: (73] Relationships: (41) Expart... = | | Proper

Normalization and Denormalization

The Normalization and Denormalization features enable you to define relationships in a

NoSQL model. Normalization splits the fields in a collection into multiple collections based

on the selected relationship type. Whereas Denormalization embeds multiple collections

into a single collection based on the selected embedding type. To access these features, on

the ribbon, click Actions. Then, click Normalization or Denormalization. For more inform-

ation, refer to the Defining Relationships Using Embedding Method topic.
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Normalization

[ ]Auto Normalization:

Source:

w.] Collection

| .:;':I Database

Relationship Type: |Auto B
Cascading
Al Single Subitem
(®Level: |0 Auto Cleanup
Cancel Help
| Details...

Denormalization

[ ]iAuto Denormalization

Target:

Source:

‘_‘E‘J Collection | ;;g”d Database

Embedding Type: ‘Embed as Auto

Cascading

Al

(@ Level: |0 =

OK

Auto Cleanup

Cancel —r
’7

Reverse Engineering and Forward Engineering Wizard Redesign

The Reverse Engineering and Forward Engineering wizards have been redesigned for better
arrangement of properties and ease of use. For more information, refer to the Reverse

Engineering and Forward Engineering topics.
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' Reverse Engineer Process Wizard O

Reverse Engineer Process Dverview
This page provides an overview of the Reverse Engineer Process,

Connection
Database
Collection

Option Set

Detail Options

Scheduler

-~ +

() Seript File

File: Browse. ..

Overview ~

Welcometo theReverse Engineer Wizard. Thiswizard lets you reverse engineerfrom the physical
database.

Reverse engineering is the process of generating the physical database schema from a physical
muodel. You can customizethe Reverse Engineer for yourtarget serverusing features in the Detail
options.

The Option Set page lets you customize the Reverse Enginser option s=t

The Scheduler pagelzts vou customize the Reverse Enginaer Scheduler options. The page dso
lets youuse Complete Compare and Martfor thetarget location.

The Owner Override page lets you enterthe owner override name of an object group. The object
group and name youindicate override the owner name assignment forthat object group in the
madel.

The Collection Filter page letsyou select asubset of thetablesin a modelfor Revearse
engineering.

The Preview page lets youpreviewthe schema DDL script generated forthe current model. W

R
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[E ' Forward Engineer 5chema Generation Wizard

Schema Generation Overview
This page provides an overview of the Forward Engineer Schema Generation.

Option Selection

Summary
Owmer Override
Table Filter

Preview

[

‘Welcame to the Fanwand Enginesr Wizard, This wirard lets youlorward engineer s model.

Farsard enginssring is the process of generating the physical detabaseschema from a physical model. You usethe Schema Generabonwizard toforwand engineer a
gaEnarate i schama, The s cubmy that you genarate indudes all oplians that are Supported i your TarQet B erver, You (an customibe the generated schamafar yowr !
wsing Features in the Schema G eneration wizard.

Thet Option Sebection page #ts you customize the Soherma Generation aption st and the databas e templae

The Susmmary page lets youreview the selacted Schema Genseration aptions in a hisrarchical tree structure. The page stso lets you enter a camment for the current
GERETI N Sption S

The Owneer Override pagelets you enter the owner override name of an object growp. The ohjed group snd name you indscate override the ownear name assignme
abject group inthe model,

The Tablke Filter page etz youselect s subsetof the tablesin amodel Farformard enginesring.

The Preview page lets youpreview the schema DOL soript generated for the curment model.

< Back Next > Geneate [ ok ] cancel

Improved Speed Mode

The Load Diagram with speed mode option now provides another option, Load Diagram

with entity/table view. This option improves the model load performance in case of large
models significantly. It does so by rendering the model in the simplest way possible, with
only the entities or tables, and their relationships. Also, by default, it disables the PK-FK high-
light feature (Display Diagram Highlight option on Model Editor).

This option is available on Tools > Options dialog box.
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Opticns

General  ¥ML  Diagnostics Reporting Mart

Messages

Reset all messages

File Locations

Default model location:

C:Wsers\admin{Onelrive - erwin, Inc\DocumentsiMy Browse

Default template location:

C:Wsers\admin{Onelrive - erwin, Inc\DocumentsiMy Browse

Transaction log location: | C:\Users\admin\AppDataLocalTemp Browse
Diagram
[ ]Suppress diagram tooltips [ ] validate previous version metadata in model

[ ]Enforce Relationship Mullability Rules [ ] Load Diagram with speed mode

[ ] supertype-subtype Transformation [ ] Load Diagram with entity/table view
[ ] Quick Complete Compare
Help Source
(®) Use online help () Use local help
QK Cancel Help
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JDBC Support

erwin DM now includes JDBC support for the following databases:
® Oracle
® SQL Server
® Azure SQL
® Cassandra
® Couchbase

" MongoDB
" MySQL
" MariaDB

Along with this, the JDBC support for Snowflake has been updated to support new features.
The JDBC database connection parameters for the above databases are as follows:

Oracle

Instance

Specifies the JDBC instance to which you want to connect.

For a cloud-based connected, the instance name is as follows:
TNS_ADMIN=<Path of unzipped cloud wallet file>

For example, TNS_ADMIN=C:\\Users\\MyUser\\Wallet DBTEST

Note: Ensure that you have downloaded, saved, and unzipped the cloud wallet
file.

Connection String

Specifies the connection string based on your JDBC instance in the following
format:
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jdbc:oracle:thin:@//<servername>:1521/
For example, JDBC:ORACLE:thin:@//localhost:1521/

For a cloud instance, the connection string is as follows:
jdbc:oracle:thin:@<dbname_priority>?

For example, jdbc:oracle:thin:@dbtest_medium?

SQL Server

Connection Type

Specifies the type of connection you want to use. Select Use Native Connection
to connect using the API provided by the SQL Server Native client software.
Select Use ODBC Data Source to connect using the ODBC data source that you
have defined. Select Use JDBC Connection to connect using JDBC.

Instance
Specifies the JDBC instance to which you want to connect.

Database

Specifies the name of the database that you want to connect to.

Connection String

Specifies the connection string based on your JDBC instance and SQL Server
database name in the following format:

jdbc:sqlserver://<servername>:1433=<SqIDBname>
For example, jdbc:sqlserver://localhost:1433

SQL Azure

Connection Type

Specifies the type of connection you want to use. Select Use Native Connection
to connect using the API provided by the SQL Server Native client software.
Select Use ODBC Data to connect using the ODBC data source that you have
defined. Select Use JDBC Connection to connect using JDBC.
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Instance

Specifies the JDBC instance to which you want to connect.

Database

Specifies the name of the database that you want to connect to.

Connection String

Specifies the connection string based on your JDBC instance and SQL Server
database name in the following format:

jdbc:sqlserver://<servername>:<port>
For example, jdbc:sqlserver://localhost:1433

Connect to Managed Instance

Specifies whether the connection should be to an Azure SQL Managed Instance.
Cassandra

Connection Method

Specifies the type of connection you want to use. Select Direct to connect to
connect to your cluster directly. Select Connection String to connect to your
cluster using a connection string.

Hostname/IP

Specifies the hostname or IP address of the server where your cluster is hosted.

Port

Specifies the port configured for your cluster.

Connection String
Specifies the path to the secure connect ZIP file in the following format:
C:\<file name>.zip

For example, C:\TempCass\secure-connect-testdb.zip

Couchbase

87



Connection Method

Specifies the type of connection you want to use. Select Direct to connect to
connect to your bucket directly. Select Connection String to connect to your
bucket using a connection string.

Hostname/IP

Specifies the hostname or IP address of the server where your bucket is hosted.

Port

Specifies the port configured for your bucket.

Bucket

Specifies the name of the bucket to which you want to connect.

SSL Certificate Path

Specifies the path to the SSL certificate, if you have one. You can leave this field
blank.

Connection String
Specifies the connection string in the following format:
couchbases://<database server>/<bucket>?ssl=no_verify

For example, couchbases://serverl.dp.cloud.couchbase.com/testbucket?ssl=no_
verify

MongoDB

Connection Method

Specifies the type of connection you want to use. Select Direct to connect to
connect to your database directly. Select Connection String to connect to your
database using a connection string.

Hostname/IP

Specifies the hostname or IP address of the server where your database is hos-
ted.
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Port

Specifies the port configured for your database.

Database

Specifies the name of the database to which you want to connect.

Connection String
Specifies the connection string in the following format:

mongodb://[username:password@]host1[:portl]],...hostN[:portN]][/[defaultau-
thdb][?options]]

For example, mongodb+srv://myusername:****
@cluster0.v7gra.mongodb.net/test PretryWrites=true&w=majority

MysQL
Hostname/IP

Specifies the hostname or IP address of the server where your database is hos-
ted.

Port
Specifies the port configured for your database.
Database

Specifies the name of the database to which you want to connect.

Note: For the JDBC connection to work seamlessly, ensure that you download the
required JDBC driver and rename it to mysql-connector-java-8.0.22.jar.

MariaDB

Connection String
Specifies the connection string in the following format:

jdbc:mariadb
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Hostname/IP

Specifies the hostname or IP address of the server where your database is hos-
ted.

Port

Specifies the port configured for your database.

Database

Specifies the name of the database to which you want to connect.

Note: For the JDBC connection to work seamlessly, ensure that you download the
required JDBC driver and rename it to mariadb-java-client-2.6.1.jar.
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